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Welcome to Ready-Set-Do!

WHAT IS READY-SET-DO!?
A set of applescripts that comprehensively integrates all of your files and programs into 
David Allen's GTD® workflow.

WHY SCRIPTS & NOT A ROBUST GUI APPLICATION?
The answer is in keeping with one of the principles in David Allen's system: Keep Things 
Simple. The value of this script set is that it works on the one thing that is not about to 
change over the next 10 years --> the File System Architecture. If you are like me, you 
absolutely hate it when a program you have known and loved suddenly no longer has 
software support, gets bought out by some bigger company, or previous versions of the 
software no longer work with the new upgrade. Because of this I have tried to keep this 
script set as simple as possible and wholly towards the things that are not about to change 
significantly over the next 10-20 years. As long as there are computers there will be file 
names and things that go with those file names. As long as Mac OS X continues to have 
both, and supports the basic features of Applescript, this script set will be reliable for quite 
some time. I originally made these scripts for just myself so that I could Get Things Done, 
but figured others could benefit from them as well. I hope you get as much out of these 
scripts as I have! Please feel free to tell others and send me any feedback or suggestions. 

READY-SET-DO! LINKS
Ready-Set-Do! Website
Purchase Ready-Set-Do!

PURCHASE READY-SET-DO!
You can order the official version of Ready-Set-Do! at the following URL:
http://order.kagi.com/?6FCSL&lang=en

http://www.readysetdo.com
http://order.kagi.com/?6FCSL&lang=en
http://order.kagi.com/?6FCSL&lang=en
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Installation Instructions

UPDATING TO A NEW VERSION OF READY-SET-DO!
Go to Applications --> Ready-Set-Do! --> 10. Ready-Set-Do! Help --> Ready-Set-Do! 
Website…

Click on the “Support” tab. Then click the “Latest Version” tab.

Download the latest version of Ready-Set-Do!

Once the Latest RSD Scripts.zip file is downloaded, unarchive the file, and double-click 
the "Install Latest RSD Scripts.” 

INSTALLING READY-SET-DO! AUTOMATICALLY
To install the scripts automatically, simply double-click the "Ready-Set-Do! Installer." Just 
follow the instructions. 

That's pretty much all there is to it. You will need to wait awhile so that it can adjust the 
Ready-Set-Do! Desktop for you. 

Once it is complete, it will tell you the installation was "successful."

INSTALLING READY-SET-DO! MANUALLY
If the installer should have any difficulties you can always manually install the scripts. To 
manually install the scripts, follow these instructions.

1. Open the folder "Files to Install" in the "Ready-Set-Do! Folder"

2. Open the folder "Ready-Set-Do!"

3. Inside of that "Ready-Set-Do!" folder is another Ready-Set-Do! folder. There are eight 
things to do here:

           (i) Rename this internal Ready-Set-Do! folder "_RSD Scripts"
        
           (ii) Navigate to the "_RSD Languages" folder. 

          (iii) Choose the folder that corresponds to your preferred language. 

          (iv) Change the name of your language folder to "_RSD Settings" (e.g. "English" -->  
"_RSD Settings")

http://www.readysetdo.com
http://www.readysetdo.com
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          (v) Make a new folder called "Ready-Set-Do!" in << your home >> --> Library --> 
Application Support --> (new folder here)

          (vi) Then move the "_RSD Settings" folder to << your home >> --> Library --> 
Application Support --> Ready-Set-Do! --> (place it here)

          (vii) Navigate to the "_RSD Preferences" folder and place it in << your home >> --> 
Library --> Application Support --> Ready-Set-Do! --> (place it here).

          (viii) Take the "_RSD Scripts" folder you renamed -- with the remaining scripts -- and 
put it into << your home >> --> Library --> Application Support --> Ready-Set-Do! --> 
(place it here).

4. Next, take the remaining Ready-Set-Do! folder and put it into your "Applications" folder.

5. Then drag that folder to the right side of your dock. (on the right side of the divider line 
in your dock - or at the top of your dock if you have the dock on the right or left side of 
your screen).

6. Then open the Ready-Set-Do! folder in your Applications folder and go to "10. Ready-
Set-Do! Help…" --> Ready-Set-Do! Droplets

7. Take the droplets found in that "Ready-Set-Do! Droplets" folder and put them on the left 
side of your dock.

8. Next, open the "Folder Action Scripts" in the original "Ready-Set-Do! Folder" --> "Files to 
Install" --> "Folder Action Scripts"

9. Take the corresponding "open - show this folder in List view" script and put it into 
<<Your Hard Drive>> --> Library --> Scripts --> Folder Action Scripts --> (Put the script 
here)
(Caution: Make sure you put it into the "Folder Action Scripts" folder and not the "Folder 
Actions" folder.)

10. If you don't already have an “ RSD Active System” folder in your home directory, go 
ahead and create one. Make sure there is a space at the front of the file name so it will sort 
to the top in list view. Then drag all of the folders in the folder "Ready-Set-Do! Desktop" to 
your this new “ RSD Active System” folder. If you already have an “ RSD Active System” 
folder in your home directory, you can skip this step.

11. Make an alias of the “Inbox” folder found in your “ RSD Active System” by using 
command-L or File > Make alias…. Then drag this alias file onto your Desktop and rename 
it just “INBOX”.

12. Then run the script “9. Make Action Lists” --> "Change RSD Prefs" by choosing it from 
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the Ready-Set-Do! icon in your dock. Choose “10 Default file path for RSD Active System” 
and navigate to and select the “ RSD Active System” in your home directory. 

Note: If you are installing your official copy of RSD manually, you'll still need to run the 
Ready-Set-Do! installer after this to obtain your official license code).

13. Installation Complete!

INSTALLING IN ANOTHER LANGUAGE (BESIDES ENGLISH)

1. Navigate to 'Files to Install' --> Ready-Set-Do! --> Ready-Set-Do! --> _RSD Languages --
> English. Then change the name of this English folder to your own language.

2. Go to file menu View > “Change View Options” and set the window to “show 
comments.”

3. Change the following variables: by selecting each folder and using File > Get Info 
(command-i) to get change the Spotlight comments to what you see below.

Global Variable #145 - Folder 
This must match the exact name for a folder in OS X (for the target language). If this is not 
exactly right, then RSD will not function properly. To check, make a new folder with Mac 
OS X set to the target language, do command-i or Get Info from the Finder, and look to see 
what it says for the kind of item.

Global Variable #146 - Alias 
This must match the exact name for an alias in OS X (for the target language). If this is not 
exactly right, then RSD will not function properly. To check, make a new folder with Mac 
OS X set to the target language, do command-i or Get Info from the Finder, and look to see 
what it says for the kind of item. It may say \"alias\" in English even though the target 
language is not. If so, then just leave it as is.

Global Variable #29 - Application Support 
The name for the Application Support folder in OS X (for the target language). << startup 
disk >> Library --> Application Support

Global Variable #30 - Applications 
Name of the Applications folder in OS X (for the target language)

Global Variable #50 - Desktop 
Very important you get this right. This is the name of the Desktop in OS X (for the target 
language). If you get this wrong, it will significantly mess up the scripts because of how 
often they use file paths that include the desktop.

Global Variable #69 - Library 
This is the name for the user's home library. This must match your system. Check your 
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home folder and change this name to match it if different in the target language.

Global Variable #23 - Users 
Name of the Users folder in OS X -- << startup disk >> --> Users

Global Variable #178 - Downloads 
The name of the Downloads folder used in OS X 10.5 and above. Change to match if 
different in the target language.

4. Run the Ready-Set-Do! Installer. 

If you would like to translate all of RSD's variables into your language, then once installed, 
run the 10. Ready-Set-Do! Help… --> Translate RSD script. This will walk you step by step 
through changing all of the variables, button names, sayings, etc. into your target 
language.

UNINSTALLING READY-SET-DO!
Just navigate to "10. Ready-Set-Do! Help…" --> Uninstall Ready-Set-Do!

THE READY-SET-DO! FILE STRUCTURE
The default RSD file structure is the following:

A folder located in your home directory named " RSD Active System"

Inside that " RSD Active System" folder are the following:

These folders --> Inbox, Actionable, Projects, Waiting For, Read-Review, Tickler, Send to 
PDA, Send to Paper

These aliases --> Reference (linked to a folder in your home directory with the same 
name), Calendar (linked to your calendar program)

Inside the Tickler folder are month folders in the following format --> 01-January, 02-
February, 03-March, etc. and a folder named "Someday-Maybe".

Inside those month folders are numbered folders from 1-31 for the days. (Note: if there are 
missing folders in your Tickler folder you can run the "Reset RSD Desktop" script located in 
Applications --> 10. Ready-Set-Do! Help… and it will recreate them.

On the Desktop are aliases linked to all of the items in your " RSD Active System" folder. If 
you prefer a “Zero Desktop”, you can trash the RSD alias files.

— ENABLING FOLDER ACTIONS —
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 If you run the installer, this will automatically be done for you, but if you are manually 
installing Ready-Set-Do! and you want this functionality, you'll need to do the following. If 
running OS X 10.4 or 10.5, you can do this by control-clicking the desktop and selecting 
"Enable Folder Actions." In 10.6 or above you can do this by control-clicking on any folder 
and choosing "Folder Actions Setup…" from the menu.

Then, for each of the following new folders on your desktop {ACTIONABLE, PROJECTS, 
WAITING FOR, READ-REVIEW, SEND TO PDA, SEND TO PAPER} click on "Attach a 
Folder Action" and select "open - show this folder in List View.scpt" found in "Library --> 
Scripts --> Folder Action Scripts --> open - show this folder in List View.scpt." If you have 
other folders on your computer you would like to open to the widest possible for your 
main display, you can add this folder action to those folders in the same way.

What this will do is ensure that every time you open one of these folders they will open in 
List view. This makes it easier to see the "Comments" field where all of the next actions are 
often specified. (Note: If you do not see the Comments field when opening one of these 
folders, go to the file menu "View --> Show View Options" and make sure the "Comments" 
box is checked. You can also arrange the windows by dragging the comments column over 
to the left to be more often in view if you have any other columns specified to show for 
any given folder.
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YOUR NEW READY-SET-DO! DESKTOP
Once Ready-Set-Do! is installed, it gives you a new desktop with the following icons. You 
can also customize this further…

• Keep the existing icons on your desktop with their default location (<< your home >> --
> RSD Active System --> (located here)
• Redirect the aliases on the desktop to other preferred locations
• Choose an alternative location for your RSD desktop by using the Change RSD Prefs 
script.

Just remember to keep the names their default names. If you want to change them to 
something else you'll need to follow the instructions under "Changing Names, Buttons, & 
Sayings."

INBOX
Put everything in this folder. This is the "bucket" through which you will collect and 
process all of your "stuff."

CALENDAR
An alias file to your iCal® application. If you use another calendar program on your 
computer then reset the alias for this to the calendar application you do use. You do this by 
selecting the icon, doing command-"i" and choosing the "Select New Original" button.

ACTIONABLE
Where all of your one-step actionable items go (i.e., anything you can do based on 
location context - @ Home, @ Office, @ Errands (Hardware Store), @ Computer, @ Online, 
@ Library, etc)

PROJECTS
Where you define, clarify, organize, and get clear on all of your more-than-one-step 
actionables.

WAITING FOR
Where you put anything you are "Waiting to/for…" hear back on or need to "Keep until…
some future date"

READ-REVIEW
Where all of your reading material goes (i.e. anything you can read based on location 
context - @ Book: Read…, @ Computer(<15min): Read…, @ Home: Read…, @ Office: 
Read…)
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TICKLER
Contains twelve months of the year as folders with numbered folders for the days of each 
month. Any time you "Defer" something it will be somewhere in your Tickler file. Any time 
you want to do something on a specific day, put it into the Month ---> Day folder. As long 
as you run your Daily Review script daily the item will pop up for your review that day.

          ---> SOMEDAY-MAYBE: The Someday-Maybe folder is located inside your Tickler 
folder. Drag and Drop anything here you want to do someday. You will be automatically 
prompted to review the items in this folder every time you run your Weekly Review script.

REFERENCE
This folder functions essentially like your physical File System at your home or office. Put 
all of your non-actionable reference  files here. The Reference folder should be located in 
your home folder and should not be moved. The desktop has an alias to this folder.  If you 
move or delete this folder from your home folder, the Weekly Review Script will not run 
properly when it asks you to check your checklists.

          ---> CHECKLISTS: Your Checklists folder is located inside of your Reference folder. 
This is where you put David Allen's 30-50,000ft Checklist, Triggers Checklists (i.e., things 
to jog your memory about things you may have forgotten about), and any other checklists 
(e.g. House Cleaning Checklist, Summer Vacation Checklist, Taxes Checklist, etc.) Every 
time you run your Weekly Review script it will prompt you to review any relevant 
checklists to jog your mind for items you may need to add to your Active System. This is 
also the folder you put any of the OmniOutliner Professional checklists you want RSD to 
interact with. For more, see "OmniOutliner Professional Interaction with RSD" below.
 
SEND TO PDA
Dummy folder for your PDA. Future versions of Ready-Set-Do! scripts may do more with 
this folder (e.g. send text files to your PDA, send your action lists to your PDA, etc). For 
now, most PDA's allow you to port text files onto them. For now, PDA-users can use the 
"Sync iCal ToDos" plug-in to sync their action lists with their PDA.

SEND TO PAPER
Dummy folder for Printing. Future versions of Ready-Set-Do! scripts will automatically 
print any files dragged and dropped to this folder. 

For more on the Ready-Set-Do! Desktop, watch this screencast.

http://www.youtube.com/watch?v=Ib8VCjJEeYI
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The Ready-Set-Do! Scripts

ACCESSING THE READY-SET-DO! SCRIPTS
There are many ways to access the Ready-Set-Do! scripts, but the easiest way to access 
them is simply to drag and drop the Ready-Set-Do! folder located in your "Applications" 
folder into your Dock and access them from there. The picture below shows what that 
looks like. If you are running 10.5 or above, choose to view the folder by "List" and as a 
"Folder." Then all you have to do is click on the dock icon and select whichever script you 
would like to run. If you are new to this, try running the Empty Your Head script first and 
jot down anything on your mind. Then go look in your INBOX and see what happened. 
Then run the Weekly Review script to get started. 

AUTOMATING IT ALL WITH ICAL
Before getting started it is advisable that you set up your Daily Review script and your 
Weekly Review script to run automatically. To do this you can make a new event in iCal, 
set the alarm, and instead of having the alarm beep or send you an email message, you 
can select to have it "Open file." Make a new calendar called "Scripts." Make a new event 
for this calendar called "Daily Review." And set this event to open the file "7. Do Daily 
Review" from your Applications folder. Then set the event to repeat everyday and the script 
will run automatically every day at whatever time you specify (You may customize it to run 
every day except for the day you do your Weekly Review; you can set this up by choosing 
"Custom" rather than "every day" for the repeat option).
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Now set up your "8. Do Weekly Review" Script to run once-a-week. Follow the same steps 
as you did for the Daily Review above but specify for it to repeat once-a-week whenever 
you want to do your weekly review (say, Fridays or Sundays at 3pm). (Caution: Be sure to 
choose "Open file" rather than "Run Script" or else the Ready-Set-Do! scripts will not 
work).

Special Note: If you install a new version of Ready-Set-Do! sometimes the link set for the 
alarm needs to be reset. If this happens just simply go to these events you made in iCal, 
choose "Open File" again, and navigate to the new "7. Do Daily Review" and "8. Do 
Weekly Review" scripts in "Applications" --> "Ready-Set-Do!" folder.

1. EMPTYING YOUR HEAD
The "Empty Your Head" Script works very simply by creating a new folder in your INBOX 
with the name of whatever you type in the dialog box. You will be repeatedly asked to 
write down your thoughts until you write nothing and click the "Done" button -- at which 
point the script will quit. Use this script any time you come up with something you want 
to jot down at any given moment and it will be put into your INBOX for you to process 
later. If you already know the location context and next action for the items you are 
entering, just use the "|" character to separate them (e.g., "New idea I just had | @ Home: 
Next action for me to do"). To see this script in action, watch the screencast. 

http://www.youtube.com/watch?v=u14yc9KXfRU
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2. GETTING INBOX TO EMPTY - Specify Location Context! 
The "Get INBOX to Empty" Script processes through each item in your INBOX asking you 
a list of questions for you to answer based on David Allen's Getting Things Done® system 
(e.g., What is it?, Is it Actionable?, Can you complete it in less than 2 minutes?, etc.). If any 
item is actionable it is very important that you specify the Location Context followed by a 
":" (i.e., colon character) for where the next action is to be done. An example is given in 
the picture below. The location for getting the next action done is "@ Library." You should 
always specify the location for getting the next action done when asked or else other 
scripts will not function correctly. To see this script in action, watch this screencast.

3. GETTING ACTIONABLES DONE
For example, the "Get Some ACTIONABLES Done" script will create a list based upon the 
location contexts you specify. Next Actions are written out to the Comments field for their 
corresponding items, so this script essentially works by getting the first word of every 
comment field in your Actionable folder on your desktop and creates this list. If you have 
consistently specified next actions based upon the location context for getting that item 
done (e.g., @ Online, @ Library, @ Anywhere, @ Computer, etc.) then you will have a list 
created like this one below. When you select an item in the list you will then be prompted 

http://www.youtube.com/watch?v=vjsxpSF0cm8
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to review each of the items you can get done in that location context (e.g., If you select 
"Online" the script will pull up each one of your Actionables which you can get done 
online). 

And if you specify sub-contexts in the format of "@ Context (sub-context): Next action for 
you to do" you can focus on a list of the sub-contexts once you've chosen your context.

Any locations with an asterisk "*" character next to them indicate that there are urgent and/
or significant tasks you need to complete associated with that context.

          



16

4. GETTING CLEAR ON PROJECTS
This script will walk you through all of the steps necessary to help you get clear on the 
elements of your projects located in the "PROJECTS" folder of your desktop. If you have 
not already clarified the outcome vision for the project you will be asked to provide the 
details. If you have already clarified those things you will be asked to review the details 
you have already provided for that project. Use this script to stay on top of your projects 
and ensure that all of the moving components of your projects are moving forward. 
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                        MORE CLARITY                                      MORE ACTION

You begin each project moving in one of two directions based upon whether the project 
needs more clarity or more action. The corresponding folders for "Project Support", 
"Primary Purpose", "Standards", "Outcome Vision", "Mission Critical", "Key Milestones", 
and "Deliverables" will all be created for you as you use this script. The following should 
give you some idea of what this script will generate for you based on your input.

— PROJECT FOLDER DEFINITIONS —

Project Support  - All non-actionable items for the project and all ad hoc thinking 
pertaining to the project begins here. Actionable pieces get dragged to Mission Critical, 
Key Milestones, and Deliverables, leaving only non-actionable support materials here.

Primary Purpose - Where you define the primary purpose of the project. 
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Standards - Where you define the expectations and standards you have for the project 
ensuring that tasks are not merely done but are done in accordance with the standards you 
want maintained for the project.

Outcome Vision - Where you clarify the successful outcome vision for the project (i.e., all 
of those things you envision being made possible as a result of completing this project)

Mission Critical - The high-priority components of the project (i.e., things that are the most 
critical to the project) organized by priority.

Key Milestones - The key milestones of the project (i.e., things that must be done in 
sequence) organized by sequence.

Deliverables - Project components that don't seem to fit into either mission-critical or key 
milestones for the project.

Any time you specify the Next Action (e.g. @ Computer: Practice French pronunciation) 
for a component of your projects, the script will automatically create an alias to that file 
and put that alias into your "Active System" based upon the content of the next action you 
specify. Your Active System consists of your Actionable, Waiting For, Read-Review, and 
Tickler folders. All of the moving components of your project will be in the Mission 
Critical, Key Milestones, or Deliverables folders with their next actions defined. Those with 
next actions defined will have aliases made and registered in your Active System; those 
which do not have next actions defined in their comments field will not be registered in 
your Active System. In the case of the item above [a. Be able to quote the French alphabet 
in less than 30 seconds] the Next Action is "@ Computer…" Thus once you have clarified 
this next action and finished clarifying the rest of your projects, a new alias will be put 
into your Actionable folder with this name and next action specified there. If you had put 
"@ Book" or "Read thru this" it would put that item in your "Read-Review" folder to be 
processed there. And if you put "Waiting for…" or "Keep until…" for the next action it 
would put a new alias into your "Waiting For" folder. 

The advantage of this is that you will never have to look at your Projects folder to see what 
your next actions are on any given project, because all of those moving parts of your 
Projects will already be in your Active System. The only time you will need to look into 
your Projects folder will be to get clear on them, to add new items to a project, or to 
simply look at your entire inventory of Projects at-a-glance. You can do this manually or by 
running the Get Clear on Projects scripts. To learn more about the Getting Clear on 
Projects scripts, see the Projects and Sub-ProjectsTutorials located in "Ready-Set-Do! 
Help…". First-time users should start with the Projects Tutorial before beginning the Sub-
Projects Tutorial.

PROJECT KEYWORDS
A few of the scripts use project keywords to automate some of the decision-making 
involved in determining whether something is a project or a task. Any file name that 



19

contains one of these project keywords is identified as a project (or potential sub-project). 
If using the Get Inbox to Empty script, the item will automatically be sent to your Projects 
folder. If using one of the Get Clear On Projects scripts, and the item is in one of your 
moving parts folders (e.g., Mission Critical, Key Milestones, or Deliverables) it will ask if 
you want to "activate" the item as a sub-project. 

Project Keywords --> Align, Assemble, Attain, Become, Build, Clarify, Compose, 
Configure, Construct, Design, Develop, Devise, Ensure, Establish, Facilitate, Finish, Forge, 
Formulate, Formalize, Handle, Harmonize, Implement, Improve, Initiate, Launch, 
Liquidate, Maintain, Manage, Mapout, Maximize, Merge, Mobilize, Navigate, Orchestrate, 
Organize, Plan, Prepare, Propose, Quantify, Realign, Re-align, Redesign, Re-design, 
Renovate, Reorganize, Re-Organize, Resolve, Restaff, Restructure, Revamp, Rolled out, 
Roll out, Set Up, Set-Up, Simplify, Spearhead, Streamline, Synchronize, Synthesize, 
Systematize, Undertake, Update

If you would like to change this list, you can now customize the list by adding or deleting 
items in the following location:
<< home >> --> Library --> Application Support --> Ready-Set-Do! --> _RSD Settings --> 
Lists --> Project Keywords --> (make changes here)

FALSE PROJECT KEYWORDS 
False project keywords are those that may contain a project keyword but that you don't 
want to be considered a project. So, for example, if you have the word "Develop" as a 
Project Keyword in the Project Keywords folder and an item with the name "Development" 
shows up, it will automatically be thought of as a project since it contains the word 
"Develop" and added to your Projects folder. To keep this from happening, just add the 
word "Development" to the "False Project Keywords" folder and it will rule that one out.

PROJECTS WITH DEADLINES
If you're anything like me you have a hard time getting the timing right to ensure you 
complete all tasks related to a project on time. And the thought of using major project-
planning software scares you as well. Wouldn't it be nice if you could just stipulate a due 
date for a project and then have a program just automatically tell you when you need to 
complete everything to get it done by then? Well now you can!! Now, when you set a 
deadline for a project you can have all of the components with next actions be 
automatically assigned due dates to ensure you complete the project on time. This is done 
in the following way:

1. Open the project that has a deadline you need to add.

2. Do command-shift-N to make a new folder.

3. Name this new folder "> DUE September 1, 2011" (or whatever date you want - just 
make sure it starts with "> DUE "

Now when the updating projects script is run, it will automatically "assign" due dates to 
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every active component in that project to ensure you get that project done on-time. This 
also automatically works with the color-coding functionality of Ready-Set-Do!.

PROJECT TAGS
Projects can now be tagged. A tag is added to a project in the following format "Project-
[TAG] Name of the project". When the updating projects script is run, all tasks related to a 
project with a tag get that tag added to its name. This is useful if you have the same kind of 
project or workflow for different clients:

Project-[Mike&Sam] Wedding Pictures Workflow
Project-[Leah&David] Wedding Pictures Workflow

So even though both projects have the exact same tasks, Mike&Sam tasks get the 
[Mike&Sam] tag and Leah&David tasks get the [Leah&David] tag. This also makes it nice 
to use the Finder search box to focus on tasks for only one project. Just open the 
Actionable folder and type "[Mike&Sam]" and only the [Mike&Sam] items show. Tasks in 
the Actionable folder show up as:

b. Narrow down these prints from 100 to 30 - [Mike&Sam]
b. Narrow down these prints from 100 to 30 - [Leah&David]

But tagging can be used in numerous other ways. Use them to assign requisition numbers 
to each of your projects. Or designate the priority of each of your projects. Or organize 
your projects with tags based on your life roles (e.g., [FAMILY], [WELL-BEING], [MONEY], 
etc.). You'll think of many ways to use this feature. And what's nice is that you don't have 
to have tags on all of your projects. Just add the further complexity when you need it; 
simplify it when you don't.

5. FOLLOWING UP WAITING FORS
This script allows you to process your Waiting Fors by going through them one-by-one. 
Waiting for items consist of anything you may be waiting to hear back on (e.g., receipts for 
orders you expect to get in the next few days, emails you are waiting for a response to, 
delegated items you may need to follow up on, or books you may have loaned out). Any 
time you specify the Next Action for an item as "Waiting for…" or "Keep until…" that item 
will automatically be put into your Waiting For folder. It is also a good idea to specify the 
date as well so you know how long you have been waiting. Thus something like "Waiting 
for package to arrive (ordered online October 12, 2005)" would be one way of keeping 
track of that; or you can simply look at the creation and modification dates for the item by 
setting that feature up in the View Options for your Waiting For folder. When you run the 
Waiting For script, you can choose to follow up items, check off the completed items, etc. 
As you make changes, the files will place themselves appropriately. Thus if you click on 
"Follow Up" on a particular item, and you specify the next action for that item is to "@ 
Phone: Call this person" or some such thing, the file will automatically make that update 
and send that file to your Actionables to be processed there. Likewise if you were to put 
"@ Book: Read the first chapter of this book" it will put that file into your "Read-Review" 
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folder to be processed there.

6. GETTING SOME READING DONE
This script works essentially like the Get Some Actionables Done script. You are first asked 
how much time you've got to get some reading done (e.g. <15min, <30min, <60min, 
<120min, >120min, Doesn't Matter). Once the time is specified, it brings up each element 
in your Read-Review folder that can be read in that amount of time (provided you have 
specified this) based upon the location context you choose. Example: If you choose 
<15min and the location context "Book" you will be prompted to review each item in your 
Read-Review folder that has "@ Book(<15min): Read this in order to…"  in its comments 
field. Specifying the location context for each next action like this will ensure you can 
process your reading based on location and time, so be sure to specify your next actions 
for reading in the format of "@ Book(<15min):" or "@ Online(<30min):" or "@ 
Computer(>120min):" You could, of course, simply double-click the Read-Review folder 
and read the files that way as well.
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7. DOING YOUR DAILY REVIEW
This script will walk you through your Daily Review. It begins by asking you to review the 
hard lines of your agenda for the day by looking at your Calendar. It then goes on to have 
you review the Tickler file for that day if you have any in the Tickler file for today. Then it 
will activate the other scripts in sequence "Get Some Actionables Done", "Follow Up 
Waiting Fors", and "Get Some Reading Done." See above for how to use iCal to 
automatically run this script every day. If you run this script every day you should stay up 
to speed on everything you've got on your plate each day. The script begins by setting the 
label colors for any items with due dates in your system. If you notice the script takes too 
long doing this, you can choose to turn this feature off by using the "Change RSD Prefs" 
script.

8. DOING YOUR WEEKLY REVIEW
This script will audibly walk you through your Weekly Review. You will be prompted to 
look at the previous week's calendar as well as future calendar dates to see if there is 
anything that comes to your mind that needs to be accounted for. Anything you think of 
will automatically be sent to your INBOX for you to process. You will also be asked to 
process your paper-based files as well so you are staying on top of those. All of this 
assumes of course that you have your file system set up based upon David Allen's Getting 
Things Done system (e.g., You have a physical inbox where every thing goes, a Tickler file 
(if you need one), an Actionable folder, a Waiting For folder, a Someday-Maybe folder, 
Agendas folder, etc.). This script will also have you go through all of your projects to get 
clear on each of them. Running this script is absolutely essential for staying on top of 
everything and not going numb to your commitments and obligations. See above for how 
to set this script up to run automatically every week using iCal.

9. MAKE ACTION LISTS
There are a number of scripts located in this folder. Whether you want to generate a 
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productivity report tracking your current progress, track all of your completed tasks, make 
a list of all of your projects and tasks, create agendas for your meetings with people, sync 
your system with iCal so you can port them to your handheld device, or zip your Ready-
Set-Do! folders to make a backup, all of those things can be done from this folder. For 
more details on these scripts, see “Exporting & Syncing Ready-Set-Do!” below.

10. READY-SET-DO! DROPLETS
Ready-Set-Do! droplets are located in your Ready-Set-Do! Help… ---> Ready-Set-Do! 
Droplets folder. The best way to take advantage of these droplets is to drag them from the 
Ready-Set-Do! Droplets folder into your dock for easy drag-and-drop access. (Note: These 
droplets work by dropping items from your RSD folders onto them). 

— Make Project Detail (Droplet) —
The "Make Project Detail (Droplet)" will make a TextEdit document providing the detail for 
that project (and all of its sub-projects) which you can then use however you wish (e.g., 
print it, archive it, send to your PDA, etc.). It essentially outputs something like the Project 
window you see under the "4. GETTING CLEAR ON PROJECTS" subheading above. You 
can also customize what aspects of the projects you want to show (e.g., Project Support, 
Primary Purpose, Standards, Key Milestones, Completed Items, etc.).

— Get Clear on Projects (Droplet) —
The "Get Clear on Projects (Droplet)" will run the Get Clear on Projects script for whatever 
selection of projects you drag onto its icon. You will notice that the "4. Get Clear on 
Projects" script will force you to get clear on ALL of your projects; but there may be times 
when you need clarity on only a few projects rather than all of them. This droplet comes in 
handy for focusing on just one or two, or however many projects you would like to get 
clear on. To get clear on just a few projects, command-click the ones you want from your 
Projects folder and drop them onto this droplet.

Hint: You may also "click" this droplet to quickly add an idea to a specific project. For 
more on projects, see the Projects and Sub-Projects Tutorials located in "10. Ready-Set-Do! 
Help…".
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— Defer Items Until? (Droplet) —
The "Defer Items Until? (Droplet)" is a fantastic way to postpone things you don't have the 
time or energy to deal with at any given time. To use this droplet just simply command-
click every item you don't want to deal with right now and drag them onto this droplet. It 
will ask you whether you want to defer these items until Tomorrow, Next Week, Next 
Month, or whatever date you specify. It will then move all of these items to the date you 
specified in your "Tickler" folder. Then once you reach that date and run your 'Do Daily 
Review' or 'Do Weekly Review' scripts, all of these items will be brought up for your 
review again to deal with as you please. Additional shortcuts for postponing include 
typing "next year", "next Monday", "Someday-Maybe", or standard date formats. If you are 
postponing more than 10 items it also gives you the option of dividing them up two-per-
day for the number of items you wish to postpone.

— Completed Items (Droplet) —
This droplet allows you to make modifications to your Ready-Set-Do! items manually by 
just dragging items onto it when they are complete. If the item is an alias file linked to one 
of your projects, "√ Completed Part" is written to the comments of the original item in 
projects and the alias is then deleted from your active system. If the item is not an alias file 
linked to one of your projects, then it asks you how you would like to follow it up -- 
specify a new, next action, send it to the trash, or send it to reference. If the item is a sub-
project, it will automatically ask you if you want to file it with its main project. Use this 
droplet when you would rather work manually rather than using the other scripts.

Hint: If you click on this droplet, rather than just dragging files onto it, you get a blank box 
that allows you to iterate newly completed items. Use this at the end of the day for all of 
those things you never wrote down but accomplished and want credit for in your 
productivity reports.
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Exporting & Syncing Ready-Set-Do!

Meeting With… 
Creates agenda sheets with all of your agenda items for a person along with waiting fors 
and a place to take notes. Just command-click the names of the people you want agenda 
notes for and the script will do the rest. Agendas must be specified in the format of "@ 
Agendas (First Last): Something to discuss with this person". You can run this script by 
selecting "Meeting With…" from the 9. Make Action Lists… section. Choose the name of 
the person you want the meeting notes for, and you get a TextEdit document in the 
following format. You can also use it now to make an agenda sheet with a time stamp for 
someone you are meeting with that you don't have an agenda for by choosing "Other…" 
from the list.

          — Agenda Items —
          @ Agendas (First Last): First thing to discuss
          @ Agendas (First Last): Second thing to discuss
          @ Agendas (First Last) Third thing to discuss

          — Waiting For —
          Waiting for First Last to get back to you (sent email 4/15/07)
          Waiting for First Last to call you about next week's meeting
          Waiting for First Last to return your book you loaned them

          Meeting Notes:

Email My Action Lists
Emails lists of your actions and projects to the email(s) of your choice. Useful for sending 
your lists to your work computer or just before a vacation or getaway if you won't have 
access to your computer. You can also set a default email for this script using the "Change 
RSD Prefs" script and then make an event in iCal to open this script on some regular basis 
to automatically email you fresh copies of your RSD system.

Generate Reports
Generates a log of all of your completed tasks and projects as well as a productivity report 
showing your averages and frequencies as well as your current productivity "belt level". To 
find out more about the Ready-Set-Do! belt levels, click here.

Make Action Lists
Creates TextEdit documents of your active system so you can keep track of things and stay 
productive even when you're not at your computer. Use this script when you need to take 
your lists with you. You can choose to do this for just one or a few contexts or for all of 
them. And you can specify what information you want to show (e.g., with contexts 
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prefixed to each task, with governing projects listed, with due dates, etc.)

Make Project Detail (All)
Creates a master list of all of your projects, including all of their individual folders and 
details. And you can customize what parts of these projects you want to show (e.g., 
Project Support, Primary Purpose, Standards, Completed Items, etc.). Use this when you 
need to see the big picture or to do a quick review on the details of your projects.

Sync iCal ToDos
Syncs your desktop Ready-Set-Do! system with your iCal todos so you can port your 
system to your handheld device. (See the Read Me file for this plug-in for more on how to 
use it).

Zip My RSD Desktop
Makes a zip file of your Ready-Set-Do! desktop folders. Use this to take your system to 
another computer, to work, or to make a quick backup of your active projects and tasks.
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Extra Functionality

NEXT ACTION SHORTCUTS
When specifying the next, physical action for an item in Ready-Set-Do!, it is possible to 
type various "shortcuts" that allow you to do further things with that particular item. Here 
are some examples of things you can type into the next action dialog box:

trash, send to trash, delete
Type any one of these and the item will be sent to the trash

file, send to reference
Type either of these and you can then choose where you want to file the item

connect to project
Type this and you can choose a project to move the item to. This is also an excellent way 
to start creating greater "vertical focus."

exit, cancel
Type either of these and you can immediately exit a script

schedule
Type this and it will bring your calendar to the front of your screen

brainstorm, collect
Type this and you can collect your thoughts directly to that item in your system

new outcome 
Type this and you can then specify a new successful outcome for something in your 
system. This is essential for keeping all items in your system fresh and moving forward.

breakup
Type this and you can break up the text in your documents into individual folders to use in 
your RSD system.

COLOR-CODING SCHEMES
There are two color coding schemes used by Ready-Set-Do! to separate your "urgent" tasks 
from your "important/significant" tasks. There is a Red-Orange-Yellow color scheme for 
urgent tasks and a Green-Purple-Blue color scheme for designating tasks connected to 
your top three projects. The Red-Orange-Yellow color scheme only works with items that 
have next actions with due dates specified in the following formats:

@ Location: Next action for you to do > Due 4/7/12
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Waiting for so-and-so to get back to you (sent email 3/4/12) > DUE September 1, 2013

The important thing to know is that the next action must end with the ">" character 
followed by the word "DUE" and then the date. The date can be specified in whatever 
format you have setup in the date settings for International Preferences. Just make sure that 
you have the date preceded by "> DUE " and the color-coding will work just fine. All items 
that are due within 1 week are colored Red. Items due within 3 weeks are colored 
Orange. And items due within 6 weeks are colored Yellow. Notice that as items come 
closer to their due date that they move from Yellow to Orange to Red.

The Green-Purple-Blue color scheme is created after you complete your Weekly Review 
and are asked to identify your top three projects for the week.

Now when processing your actionables, reading, or waiting fors they will process in the 
following order:
Red Items 
Orange Items
Yellow Items
Green Items
Blue Items
Purple Items
Uncolored items

So if you choose your "@ Home" context, you will process all of your Red items for that 
context first, then orange, then yellow, then green, blue, purple. And then any that have no 
color assigned to them. That way you are always working on your urgent items first, your 
important/significant items second, and then all the rest. This keeps you ahead of the game 
and ensures nothing slips through the cracks.

MAIL RULE TO RSD DESKTOP FOLDERS
A mail rule that allows you to interact with your Ready-Set-Do! folders on your computer 
from any other computer with email access. This Mail Rule takes messages with certain 
criteria in the subject lines and can save those emails — along with their attachments — to 
various places in the RSD desktop folders. It can be used by sending yourself emails from 
other peoples' computers, or your work computer, or your cell phone, so that things 
automatically file into your RSD system. Uses include the ability to send a bunch of 
documents to yourself in an email and have them all go to the Send to Paper folder on 
your desktop to print later. Or you can send yourself a task to do and write "> Tickler 
10/10/13 in the subject line and have this placed in that date of your Tickler file. It also 
automatically takes any tasks you delegated to somebody else by email and updates your 
Waiting For items with those changes once the person responds to your email. There are 
many uses. To learn more on how to set this mail rule up, see the Read Me file for the RSD 
Mail Rule located in the Plug-Ins Read Me folder.

There is also a shuttle feature that allows you to request items from your RSD system via 
email as well as mark them complete. To use this feature, simply take one of your Action 
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Lists sent to you by email, choose the number of the item you want to interact with, and 
do the following: Forward the message to yourself and add ">" to the end of the subject 
line followed by the number you want and either the "+" or "-" sign depending on what 
you want to do. Example:

Fwd: _My Actionable > 10+ -- requests item number 10 to be sent back to you via email.

Fwd: _My Actionable > 10- -- marks this item complete in your RSD system on your 
computer.

You receive an email with the subject line "Your request for ACTIONABLE item #10"

Once you are done working on it, you can now choose to forward the message to yourself 
and do the following:

(a) Fwd: Your request for ACTIONABLE item #10 >-

(b) Fwd: Your request for ACTIONABLE item #10 >@

The "-" added to the end will mark the item complete in your RSD system on your 
computer.

The "@" added to the end will modify the Spotlight comments for the item in your 
RSD system on your computer

-- you specify the next action by typing it at the very top of the newly forwarded 
email

Note: in order for this functionality to work, the Mail Rule to RSD Desktop script must 
always be running. It checks the Inbox in Mail.app every 3-minutes for emails that match 
the criteria for RSD processing. 

OMNIOUTLINER INTERACTION WITH RSD
Sometimes you have items in your inbox that require special processing. Maybe you keep 
a database of information on books or you need to track certain information on emails you 
receive. Ready-Set-Do! works with OmniOutliner to help you customize the processing of 
items based on your unique needs. You must have OmniOutliner for this to work. In order 
to use this functionality, when the "What is it?" box comes up when processing your Inbox, 
you can type "! Purchase-Name of item" in order to bring up one of your OmniOutliner 
documents. The "!" character tells the script to interact with OmniOutliner. The "Purchase-" 
tells it what document to locate in your Checklists folder found in << your home >> --> 
Reference --> Checklists. In order for the correct checklist to be located, you must create a 
new OmniOutliner document that begins with a "!" character followed by a space and 
then some sort of prefix (e.g., Purchase) and then the "-" dash character. This helps RSD 
find the document quickly and then allows you to interact with it. A sample Quotes and 
Purchase List have been included so you can see how it works.
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Hint: You can also invoke the OmniOutliner interaction with the "!" character and a prefix 
(e.g., Purchase-) as a next action shortcut.

You can make checklists of your own in OmniOutliner and RSD will interact with them 
provided they are located somewhere in your Checklists folder and begin with the "!" 
character and a prefix followed by a dash. So if you wanted to start a new "Jobs Checklists" 
to track searching for new jobs, you could call it "! Job-My Jobs Checklist" with the 
columns of "Type of Job", "Date Applied", "Contact Info", "Address", "Extra Notes", etc.. 
Then any time you want to interact with it, you can type ! Job- followed by whatever the 
item is you are naming and it will invoke this OmniOutliner Professional document for 
you to interact with.

THE READY-SET-DO! BELT LEVELS
Included with this version of Ready-Set-Do! is the ability to generate a Productivity Report 
that includes rating your productivity level. Anybody who has read Getting Things Done by 
David Allen knows that the inspiration for this approach to productivity comes from his 
own training in the martial arts. Ready-Set-Do! adds a little fun to getting things done by 
allowing users to graduate from one belt level of productivity to another depending upon 
how well they are juggling the GTD habits. There are a total of 10 belts in the order of 
White, Yellow, Orange, Blue, Green, Purple, Brown, 1st Degree Black Belt, 2nd Degree 
Black Belt, 3rd Degree Black Belt. Every time a user graduates to a new belt, she receives a 
description of what that new belt level means along with advice for graduating to the next 
belt level. These belt level descriptions are known only by the creator of Ready-Set-Do! 
and will not be made public. Thus the only way to discover what each of these belt levels 
means is to use the scripts and graduate to that level. 

RSD OUTCOMES SCREEN SAVER
The RSD Outcomes Screen Saver allows you to see the successful outcome visions for 
each of your projects scroll across the screen during down-times, or times when you need 
some motivation. Here's how to set it up…

1. Complete a Weekly Review so RSD can make an updated RSS file for the RSD 
Outcomes Screen Saver to use.

2. Open System Preferences > Desktop & Screen Saver. 

3. Under "Other" - select the RSD Outcomes Screen Saver. (If you don't see it there 
you may need to log out and then log into your user account again.) 

4. Then click the "Options…" button

5. Go to the Finder and navigate to << your home >> --> RSD Active System --> 
RSD_rss.xml

http://www.amazon.com/Getting-Things-Done-Stress-Free-Productivity/dp/0142000280
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6. Take that RSD_rss.xml file and drag it to the Desktop & Screen Saver window - 
drop it onto the "feed URL" box there.

7. Change the article display duration to about 11 seconds.

8. Click the "Done" button and then test out the screen saver and see what you 
think.

READY-SET-DO! 8-BALL
 The Ready-Set-Do! 8-Ball can be used in two different ways:

    a) Dropping files onto it
- attaching a note to a file or folder
- breaking a text file apart into individual folders
- processing the text in the file—one line at-a-time—to help you 
collect your thoughts

(b) Clicking on it
The purpose of the RSD 8-Ball is to add a little variety and help to your experience 

of Ready-Set-Do!. Here are the options that come up when clicking the RSD 8-Ball:

Get Motivated 
Individually takes you through each of the successful outcomes for your projects to help 
motivate you to get them done. You can use this at key times during your day to help you 
visualize these outcomes (e.g., early morning, before bed, etc.).

Clear the Decks
Allows you to quickly go through your inventory of projects and tasks so you can defer 
what isn’t important to your Tickler or Someday-Maybe folders. It then queues up the Get 
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Some Actionables and Get Some Reading Done scripts to process what you’ve left to focus 
on.

Get Clear, Current, & Complete
Takes you through a complete weekly review.

Do Something
Randomly picks either Get Some Actionables Done or Get Some Reading Done scripts.

Purge Something
Allows you to choose a folder to purge and work through it to get rid of stale items you 
don’t want or need anymore. The default is to choose a random folder from your Reference 
folder in your home directory to purge. From there you can select an alternative one to 
purge.

Help! I’m Overwhelmed
Walks you through a checklist of things you can do to gain perspective and control on 
your projects and tasks. Use it whenever you are feeling overwhelmed.

Surprise Me! 
Randomly picks one of the above items.
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Customizing Ready-Set-Do!

CHANGE RSD PREFERENCES
There are numerous ways to customize your experience of Ready-Set-Do!. Most of them 
are found when using “9. Make Action Lists… --> Change RSD Prefs.” For more on what 
each of these preferences do, watch the “Changing RSD Prefs” screencast.

Here are the current preferences:

01 Global Audio --> On/Off/--
02 Email Action Lists Default Email --> <<type your default email>> (you can then use 
iCal to automatically send you a fresh list via email at the interval you choose. Instructions 
are similar to “Automating it all with iCal.” You just choose “Email My Action Lists” script 
instead.)
03 Sync iCal Documents --> On/Off
04 Staleness --> 90 (default is 90 days; change based on number of days before you 
consider something in your system getting "stale")
05 Troubleshooting --> On/Off (turns notifications on/off when the scripts encounter 
errors)
06 Mailbox name to file processed email for Mail Rule scripts --> Trash (default is to send 
the email to the trash, but you can choose a different email mailbox/folder for the Mail 
Rule scripts to save those emails to once it's in your RSD system)
07 Language Preference --> English (you can choose your preferred language if it is 
supported for RSD)
08 Label Marking Before Daily Review --> On/Off (you can turn this on or off depending 
on how long it seems to take
09 Voice Preference --> Alex (default is Victoria for 10.4; Alex for 10.5; you have to type a 
supported voice name for OS X)
10. Default Filepath for RSD System --> In case you don't want to use the alias files on the 
desktop or you want to relocate your RSD Active System folder to another location 
(including a remote server or USB-drive) you can choose the path where you've located 
your RSD system.
11. Sync iCal Todos - All ToDos to iCal Calendar #1 --> On/Off
12 Hide Web Browsers when Processing Inbox --> On/Off
13. Add/Modify Auto-File Prefixes --> Choose this to add file prefixes to speed up your Get 
Inbox to Empty processing. For more, see “Auto-File Prefixes For Get Inbox To Empty 
Script.”

ZERO DESKTOP
Some people like to have a completely clean desktop with no icons and would prefer not 
to have the Ready-Set-Do! icons on their desktop. Ready-Set-Do! installs alias files that 
link to the original files in the “ RSD Active System” folder in your home directory. The 

http://www.youtube.com/watch?v=E5q1WeRtmFo
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aliases on the desktop therefore do not need to be on your desktop. You can throw the 
alias files away if you prefer to have a zero desktop or find having them on your desktop 
distracting.

AUTO-FILE PREFIXES FOR GET INBOX TO EMPTY SCRIPT
When processing your inbox, you may tire of answering the same questions for items you 
already know where they go. For items like this, RSD makes it possible to automatically 
file them based on special prefixes you choose to make. So let's say you have a "Receipts" 
folder in your Reference and you would like any item you prefix with "Receipt-" to go 
there. All you have to do is launch "Change RSD Prefs", which is located in Applications --
> Ready-Set-Do! --> 9. Make Action Lists --> Change RSD Prefs. Choose 13 Add/Modify 
Auto-File Prefixes. And then type the prefix you want to use. Click "Ok" and then navigate 
to the folder you want those things to go to. 

Note: Just be careful that you follow your prefix with a dash or some other non-letter 
character. If you made a prefix just "R" for receipts, this would also automatically file 
anything else you process that begins with the letter "R". Want to see Auto-File Prefixes in 
action? Watch the “RSD Auto-File Prefixes” screencast. This will significantly speed up 
how quickly you process your Inbox. So give it a try!

TRANSLATING READY-SET-DO!
The default language for Ready-Set-Do! is English, but RSD can be translated into any 
language using “Translate Ready-Set-Do!” located in “10. Ready-Set-Do! Help…” Launch 
this script and you’ll be walked, step-by-step, through translating every file name, button, 
and saying RSD uses. When complete, there will be a new _RSD Settings folder you can 
submit to the creator of Ready-Set-Do! to be packaged with future releases.

CHANGING NAMES, BUTTONS, & SAYINGS
All names, buttons, and sayings in Ready-Set-Do! can be customized to your liking. 
Ready-Set-Do! does a lookup from the comments fields found in ~/Library/Application 
Support/Ready-Set-Do!/_RSD Settings to find the appropriate item to use for each name, 
button, or saying. Suppose you’d like to change the “Defer until” button to “Later” instead. 
All you have to do is navigate to the _RSD Settings/Buttons folder. Set the View options for 
the folder to show you the Spotlight comments. Find the button that says “Defer until” in 
the comments field and type “Later” instead. Next time you run Ready-Set-Do! the button 
will be changed to “Later.” The same approach works for Sayings in the “Sayings” folder 
and dialogs in the “Dialogs” folder.

WORKING FROM THE CLOUD OR USB-DRIVE
Would you like the flexibility to use RSD in the cloud, a remote server, or a portable USB 
drive? No problem. Navigate to the place you would like your Ready-Set-Do! system 
located. Create a new folder called “RSD Active System.” Then use “9. Make Action Lists” 

http://www.youtube.com/watch?v=xbsY9Fb9XCM
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--> “Change RSD Prefs” --> “10 Default Filepath for RSD System.” Then navigate to your 
new RSD Active System folder. RSD will recalibrate the alias files on your desktop to 
connect to their new locations in the cloud, your remote server, or your portable USB 
drive. RSD will now work of this new location of your RSD Active System folder. 

Note: Keep in mind that some cloud-based servers do not do a very good job of syncing 
metadata along with the files themselves (e.g., the Spotlight comments). Keep a backup of 
your RSD Active System while you experiment with your cloud-based service to ensure the 
Spotlight comments are preserved as you use RSD with remote servers. 
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Support

SOME TIPS & TRICKS
1. Always specify Next Actions for items in the format of "@ Phone: …" or "@ Home: …" or 
"@ Office…" etc.

2. Make a regular habit of putting everything that comes to you into your INBOX and 
running the Get INBOX to Empty script.

3. Don't forget to run your Daily Review script daily! If you miss a day you may have to 
MANUALLY check that day's Tickler file in your Tickler folder because there was no script 
run to remind you of it on that day. Set this Daily Review script to run automatically 
everyday using the iCal alarm and you won't have to remind yourself to do this every day.

4. Run your Weekly Review Script weekly (or whenever you need a full inventory of your 
commitments and obligations). As David Allen points out in his book, consistently doing 
the weekly review is the key habit to learn in order to stay on top of things. Set this up 
using the iCal alarm and you won't have to remind yourself to do this every week.

5. Normally when you have something on your mind you should just use the Empty Your 
Head script, but what if you have something on your mind related to one of your Projects, 
and you would like that idea to go to that project in your Projects folder rather than to 
your Inbox? The best way is to add an idea you have to one of your projects is to click the 
"Get Clear on Projects (Droplet)" icon OR you can do it MANUALLY by using "Command-
Shift-N" to make a new folder in that Project's folder.

6. Make your Action Lists or Project Detail lists right after you've completed your Weekly 
Review. That's when you've got everything up-to-date. Then you can either print them out, 
archive them, or put them on your PDA as a text file.

7. Don't forget your Paper Based system!! Make sure you have and process your physical 
inbox at your home or office. Make sure you review your Paper-Based Projects and 
Actionables. Don't let these slip just because you've got everything together on your 
computer. If you run the Weekly Review script, it will audibly walk you through getting 
clear, current, and complete for both your paper-based and computer-based inventories.

8. If some next action isn't the way you like it, you can always MANUALLY change that 
next action by selecting the item and doing "Command-i" or control-clicking that item and 
choosing "Get Info." Then just change the next action to what it's supposed to be.

9. David Allen's system takes some getting used to, but the pay off is immense. One trick 
I've learned is to run the "Get Some ACTIONABLES Done" script, select the location I want 
to focus on, and to just simply DO whatever the first thing is that shows up. Doing this 
gets me in the DOING mode rather than the REVIEWING mode. Doing this has kept me 
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on track when there is a temptation to simply click "Next", "Next", "Next" rather than doing 
what shows up. Try this and see if it works for you.

10. Save any actionable emails as files to your Inbox. Then process them like you would 
anything else. Doing this will keep you from having to bounce back and forth to your 
email program to see any actionables you have hiding there. You may also choose to set 
your INBOX as your default downloads folder for your web browser or other programs.

STAYING ORGANIZED: SOME DO'S & DON'TS
1. DO put everything in your INBOX. 
The best way to keep your system clean and organized is to put anything new you receive 
into your INBOX. Everything should go here first. If you currently have anything on your 
computer that you don't know what it is, that too should be put into your INBOX to be 
processed.

2. DON'T rename the Ready-Set-Do! folders unless you follow the instructions for doing 
so in "Changing Names, Buttons, & Sayings" 
It is incredibly important that you do not move the Ready-Set-Do! folders from the RSD 
Active System folder. Changing the names of these folders or moving them out of that 
folder will result in problems running the scripts. If you have changed the names of these 
folders, change the names back to their original names.

3. DON'T move or rename the "Reference" or "Checklists" folders in your home folder. 
If you change the names of these folders, delete them, or move them from your home 
folder, the Ready-Set-Do! scripts will not work properly. 

4. DO keep all of your reference materials in your "Reference" folder and treat it as you do 
your physical filing system. 
Staying organized means learning to file things appropriately into this Reference folder. 
Personally I even keep things that would normally go into my "Documents" folder in this 
Reference folder so I have everything in one place.

5. DO add new checklists to your Checklists folder.
Any checklist you find on the internet or design yourself should be put into your Checklists 
folder. Keeping all of your checklists in this one place will ensure that you are reminded to 
check them whenever you run your weekly review script. Of course, you can also simply 
check them on your own by manually double-clicking and opening this folder in your 
Reference folder. As long as you do not move or rename this folder you can add as many 
checklists to this folder as you wish, categorize them by subject matter, etc. just as you 
would any other folder on your computer. 

6. DO backup your computer regularly. 
If you keep everything where it should be -- your Ready-Set-Do! folders in RSD Active 
System folder, your Reference folder in your home folder, etc. all you really need to do is 
backup your Reference and RSD Active System folders regularly, since that’s where 
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everything is. And because your RSD Active System has all of your "Active" components, 
it should be backed up more frequently. Your Reference folder (along with anything else 
important in your home folder) can be backed up on a less frequent schedule since 
changes are made less frequently to it in comparison to your RSD Active System folder.

REVIEW: That's pretty much all there is to keeping your system organized. So to review: 

          (i) Anything you are unsure of or is new, put into your INBOX to be processed
  
          (ii) Don't move or rename any of the Ready-Set-Do! folders in your RSD Active 
System (unless you follow instructions for this)

          (iii) Do not rename or move the "Reference" folder from your home folder

          (iv) Do not rename or move the "Checklists" folder from this Reference folder

          (v) Treat this new "Reference" file in your home folder as you would your physical 
filing system by putting non-actionable reference materials there

          (vi) Add any new checklists you think of or find or make to your new "Checklists" 
folder located inside of the Reference folder located in your home folder.

          (vii) Stay organized by keeping reference materials in Reference and keep only 
active components in your RSD Active System folder. This will make backing up your 
system more streamlined (e.g., you could back up your RSD Active System folder every 
couple days or so and back up just the newly modified elements of your Reference folder 
every week or month or as often as you feel you need to).

TROUBLESHOOTING & KNOWN ISSUES

For the latest information and support, visit http://www.readysetdo.com and click on the 
“Support” tab.

TECHNICAL SUPPORT, QUESTIONS, REGISTRATION

Email: readysetdo@mac.com

DISCLAIMERS

GTD and Getting Things Done are registered trademarks of David Allen & Co. 

Mac OS and iCal are registered trademarks of Apple Computer, Inc.

http://www.readysetdo.com
mailto:readysetdo@mac.com
http://www.davidco.com/index.php
http://www.apple.com
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